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What’s New in ADMS 6? 
March 2023 

 

 

 

ADMS 6 is the latest general release of CERC’s state of the art model for the dispersion of 

pollutants. ADMS 6 contains a number of new features and model options, most notably: 

 Several enhancements to the modelling of buildings, including the ability to 

automatically determine a main building, easier plotting of the effective building and 

changes to the way the effect of buildings are modelled, particularly for upwind 

sources; 

 An option to facilitate the calculation and visualisation of the contribution of 

individual sources to specific receptors; 

 Enhancements to the modelling of time varying emissions factors, including the 

ability to specify profiles on a per source per pollutant basis in the .fac file along with 

improvements to the entering of time varying emissions factors on screen; and 

 Many new usability features in the Mapper and ADMS 6 interface including increased 

output limits, a utility to easily create .asp files containing several different sets of 

gridded output points; functionality to export data in the Mapper to .spt files for 

import into ADMS 6 and the ability to calculate on-site or off-site maxima of model 

output. 

 

This document contains details of the new features, scientific improvements and model 

corrections implemented since the last release of ADMS 5.2 (November 2016).  Also 

contained in this document are instructions for installing ADMS 6 and upgrading from 

previous model versions. 

 

 
In this release 

This version of ADMS 6 includes an updated user interface, model, utilities and User Guides.  

The ADMS 6 User Guide and supplementary User Guides can be found in the ‘Documents’ 

sub-directory of the ADMS 6 install directory. 
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Installation 

Before installing ADMS 6 

Log on to your computer as Administrator, and uninstall any previous version of ADMS by 

selecting Programs and features from the Windows Control Panel. 

 

Installing ADMS 6 

If you have not already done so, log on to your computer as Administrator. 

ADMS 6 will have been supplied by download link.  Extract the downloaded .zip file to a 

local directory.  In Explorer, browse to this directory and double-click on the file ‘setup.exe’. 

Follow the instructions on the screen.  Further details are given in Section 2.2 of the ADMS 6 

User Guide which can be downloaded from the CERC website.1 

You should also have been provided with a new licence file, which is required in order to run 

the model.  To install the licence rename the file to ADMS.lic and then copy it to the directory 

in which the model is installed. 

The first time that you launch the model after installation, it is important that you are 

connected to the internet so that your licence can be registered. 

New versions of the GIS links you require (ArcGIS, MapInfo) can be installed by following 

the instructions in the ADMS 6 User Guide. 

  

                                                 
1 https://www.cerc.co.uk/UserGuides  

https://www.cerc.co.uk/UserGuides
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Upgrading your input files 

Additional input (.aai) files 

Any additional input (.aai) files must also be updated so that they are in file version 4 format.  

To do this: 

1. If you wish, make a backup copy of the original .aai file in Explorer. 

2. Open the Additional Input file editor, which can be accessed via the Edit button on the 

Setup screen of the ADMS 6 interface. 

3. Open the .aai file via the File menu. 

4. Click Yes to the automatic upgrade message that appears to allow the editor to 

upgrade the file. 

5. Save the .aai file via the File menu. 

6. Reference the new .aai file in the Setup screen of the ADMS 6 interface. 

 

Users of the amine chemistry module have additional steps to follow to upgrade their .aai 

files.  See the Amines Chemistry Supplement User Guide for full details. 
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New Features and Major Changes 

Mapper 
 

Full details on using the Mapper can be found in the Mapper User Guide. 

1. Layers containing source information, e.g. a shape file of point source data, can be 

exported for .spt format so that they can be easily imported into ADMS 6. See Section 

5.12.2 of the Mapper User Guide for more details. 

2. A new ‘Clip layer to polygons’ tool allows individual features from one layer to be 

‘clipped’ to the polygon(s) from a separate layer. The resulting set of clipped features 

are saved to a new shape file rather than replacing the original layer. See Section 5.13 

of the Mapper User Guide for more details. 

3. Statistics about a particular layer can be viewed using the new ‘Layer statistics’ tool. 

Namely, the minimum, maximum and X, Y location are reported for each numerical 

field in the layer. Up to five filters can also be applied to the layer to constrain the 

number of features/data points on which to calculate the statistics. See Section 5.14 of 

the Mapper User Guide for more details. 

4. The geometry of all features in a particular polyline/polygon layer can be simplified 

simultaneously using a new ‘Simplify layer’ option. This can help to reduce vertex 

counts to within model limits. 

5. Two new gridding methods have been added to the Interpolator to generate contour 

layers – triangulation and natural neighbour. 

6. When a contour layer is created, a separate layer that displays the contour lines is also 

added. 

7. The transparency of individual contour levels can now be altered. This can be useful 

for ‘seeing through’ certain regions of a contour plot. 

8. Information tool: 

a. Holding down AltGr ensures that only features in the currently selected layer 

can be clicked. 

b. Raster layer (e.g. contour plot) values are now displayed in the status bar as 

you move your cursor across the layer, or displayed in the attributes table if 

you click on a particular point. 

9. There have been various changes to improve usability: 

a. There have been several changes to the main and right-click menus. 

b. It is now possible to move the output grid and rotate a source or building. 

c. There are now three tabs in the layer panel; the Layers tab shows the layer 

order hierarchy while the Grouping tab shows which group each layer belongs 

to. 
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10. If the coastline module is being used, the line representing the coastline and the point 

on land are now displayed and editable in the Mapper. 

11. When using the ‘Extract data’ option in the Mapper, the Output extent can be edited 

in the Mapper while the form is open.  The Layers table now displays more 

information about the selected layer including its spacing.  For more details on the 

‘Extract data’ option see Section 5.6 of the Mapper User Guide. 

12. When attempting to export a layer in a coordinate system which differs from the map 

coordinate system a choice of coordinate systems to export to will be given. 

13. Mapper layer settings are now stored in .ttkstyle files rather than .ini files. 

14. When adding a layer to the Mapper from a comma separated variable file, polylines 

and polygons can now be imported in addition to points and single-segment lines.  See 

Section 5.5.3 of the Mapper User Guide for details on the format of the header to use 

for each of these options. 

15. An option to ‘Use Map coordinate system’ has been added to the ADMS 6 interface.  

This option can be used when using a custom coordinate system for the input data. 

16. Circular area and volume sources can now be defined using the ADMS Mapper.  To 

define a circular area or volume source, select the appropriate layer in the Legend (e.g. 

the Area sources layer), click on the Add Feature button on the toolbar, then click on the 

drop down arrow next to the button and select Circle. 

Interface 
17. There have been various changes to the format of the .spt file (and related files) for 

data import/export (see Section 5 of the ADMS 6 User Guide for full details): 

a. The format of the data in the .ptt file, used for importing data to and exporting 

data from the pollutants palette, has changed slightly for particulate pollutants 

containing multiple particle species.  Lines in the file corresponding to the 

second and subsequent particle species should have ‘n/a’ entered in all 

columns except for the pollutant name, deposition velocity, terminal velocity, 

particle diameter, particle density and mass fraction.  Please see the ADMS 6 

User Guide for full details of the format of the .ptt file 

b. Parameters which are not required can now be left blank (or ‘n/a’ or ‘na’) 

c. Old format files can still be imported, and data can still be exported in the old 

format using the ‘Use legacy format’ tick box 

d. Sources with more than the maximum number of allowed vertices can still be 

imported, but the .apl cannot be saved until the number of vertices have been 

reduced accordingly (see also #4). 

18. Various limits have been increased: 
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a. The maximum length of all names (sources, buildings, groups, pollutants, 

receptors, profiles) has increased from 20 to 30 characters 

b. The maximum number of pollutants in the palette has increased from 30 to 

100 

c. The maximum number of pollutants emitted per source has increased from 10 

to 80 

d. The maximum number of entries in the pollutant output table has increased 

from 30 to 80 

e. The maximum number of outputs per run has increased from 10 to 25 

19. The table columns in the Source screen and Output screen are now resizable. The 

order of the columns in the sources table has also changed. 

20. ADMS-Urban and ADMS-Roads model files (.upl files) can now be opened directly 

in the ADMS 6 interface. Warnings will be issued about any model incompatibilities 

resulting in disabled options. The file can then be saved as a regular .apl file. 

21. Right-click menus have been added to various screens in the ADMS 6 interface and 

utilities to allow for the following additional functionality: 

a. Set the start date and time to that of the met. file or to the end date and time, 

and vice versa, when using a subset of met. data. 

b. Choose the application with which to open an input file (Notepad, Wordpad, 

Excel, Other) on the View buttons 

c. Create a copy of a specified point 

d. Delete all but the selected entry in various tables (sources, buildings, specified 

points) 

e. Invert the selection of variable grid coordinates 

f. Refresh the list of files in the 2-D Output Plotter 

22. Multiple copies of the interface can be used simultaneously.  This is particularly 

useful for comparing two .apl files side by side. 

23. It is now possible to open an .apl file from Explorer by right-clicking on it and 

selecting Open with ADMS 6 or Open with ADMS-Screen.  Also, double-clicking on an .apl 

file in Explorer will cause it to open in the most recently used model interface. 

 If .apl files were previously associated with another program, such as a text editor, 

on your computer, then this new feature may not be available to you.  In this case, 

please contact CERC for advice on how to change the association of .apl files. 

24. Additional information about your model licence is available from the Licence details 

screen on the Help menu.  The licence file path and licence number can be copied and 
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pasted into other documents using the Copy  buttons.  The licence can be located in 

Explorer using the Find  button.  The number of sources, groups and buildings that 

can be modelled with your licence can be seen by clicking Details. 

25. It is now much easier to enter percentiles and exceedance thresholds in the Output 

screen. New values can be entered by typing the number and then pressing Enter.  The 

full table of entries can be opened via the drop down arrow and closed via a right-

click menu. 

Buildings 
26. There have been several enhancements to the way the effects of buildings are 

modelled, particularly in the case of sources which are upwind of the building.  To 

allow consistency with previous modelling, when required, a new .aai option has been 

added which allows these new developments to be switched off, see Section 4.9.5 of 

the ADMS 6 User Guide for more details about this option. 

a. When a plume upwind of the building impacts onto the face of the building, 

the plume will now split into up-to three parts going round and over the 

building.  These plumes will then be used for the calculation of entrainment 

into the cavity region and for the dispersion of the non-entrained material in 

the main wake.  Previously a single plume was modelled for this case. 

b. The secondary plume emanating from the cavity region is now modelled as a 

line source element.  Previously this was modelled as a virtual point source. 

The use of a line source better represents the distribution of concentration 

emanating from the well-mixed recirculation region, in particular immediately 

downwind of the recirculation region.  

c. Changes have been made to ensure consistency when the model selects an 

alternative main building.  In all cases the closest eligible building will now be 

selected.  Previously different behaviour would be seen depending on whether 

the nearest alternative building within the region of influence was too low 

compared with the source. 

27. There is now an option to specify that the model should always automatically select a 

main building for a particular source.  This option is specified by selecting “(Auto)” 

as the ‘Main building’ for this source in the Source screen.  When using this option 

the closest building which is tall enough (met. line independent) and within the region 

of influence of the source (met. line dependent) will be selected. 

28. It is now possible to model the effects of buildings and fluctuations within the same 

run. 

29. When running in verification mode a .bef file will now be output showing the 

effective building for each source for neutral conditions for a range of wind 

directions.  The wind directions used for this can be altered in the additional input file.  

When carrying out the full model run the .bef file will be created based on the 

modelled meteorological data as before. 

30. The format of the .bef file has been altered to allow it to easily be plotted as a series of 

polygons within the Mapper, see also point 14. The effective building heights have 
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also been added to this file. 

31. Output points within input buildings will now have their output concentration set to 

zero within the comprehensive output file for consistency with the output given in all 

other files. 

Time varying emissions 
32. The use of time varying emissions data from a .var file or .fac file is now specified on 

the ‘Time varying emissions’ screen.  This can be accessed by turning on ‘Time-

varying source data’ and clicking the Data… button in the Source screen. 

33. There are various new features if entering on-screen time varying emission factors 

(see Section 4.1.3 of the ADMS 6 User Guide for full details): 

a. There is now a choice for which source types to apply the time varying 

emissions factors to.  Any sources not selected will have a constant profile. 

b. The sum and average of each diurnal profile (Weekdays, Saturdays, Sundays) 

is displayed, as well as the overall sum and average 

c. There is a Normalise button that adjusts the factors so that the overall average 

equals one 

d. There is a graph that plots the time-series of each diurnal profile 

e. There is a Save button that generates a .fac file from the on-screen data, which 

can then be modified further in a text editor if desired 

f. The on-screen factors can also be imported from/exported to a simple .csv file 

g. It is possible to copy the factors from one profile to another by right-clicking 

on the header 

h. Values can also be pasted from Excel or a tab-separated text file into the table 

34. Time-varying emission factor profiles in the .fac files can now be applied to a 

particular source-pollutant combination. See Section 4.1.2 of the ADMS 6 User Guide 

for more details. 

35. The header required for water content to be specified in the .var file has been 

corrected to H2O (i.e. uses the letter O).  The previous header of H20 (i.e. uses the 

number 0) will still be accepted for compatibility. 

Complex terrain 
36. A correction has been made to the location of the well mixed region in complex 

terrain, in cases where the recirculation is shallow compared to its width and the 

source is near the downwind edge of the recirculation region. 

37. A higher grid resolution of 512 x 512 has been added for the internal flow field 

calculations when using complex terrain.  Correspondingly, the terrain and surface 

roughness files can now contain up to 770,000 lines of data. 
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38. The user can now select the vector gridding method in the 2-D Output Plotter when 

using the Surfer gridding option. 

39. When modelling with variable terrain height, the minimum turbulence value is now 

set based on the size of variation in terrain height.  As this variation reduces, the 

minimum turbulence used will return to the value used for flat terrain. 

40. Changes have been made to ensure consistency when modelling variable roughness 

with a nearly flat terrain file and without a terrain file at all. 

a. The blending function applied to the turbulence calculations is now only 

applied to the terrain component.  Previously this blending function would 

also be applied to the roughness component if variable terrain was being 

modelled. 

b. The constraints on the variation of velocity in variable roughness are now 

always applied to the change in velocity due to the variable roughness, 

previously they would not be applied if variable terrain was also being 

modelled. 

41. When modelling complex terrain, passive plumes will no longer penetrate the 

boundary layer due the vertical velocity in the flow field. 

Meteorology 
42. Year/Day/Hour and wind direction have been added to the boundary layer profile 

output (.pro) file. If only one height is defined in the .pro file, this means it can be 

plotted using the Wind Rose Viewer utility, allowing a dispersion site wind rose to be 

plotted. 

43. There have been several changes to the format of the vertical profile files, .prf.  For 

full details on this new format refer to Section 4.17 of the ADMS 6 User Guide. 

a. Year/Day/Hour can now be used in place of Met. Line number.  This helps 

with matching to the meteorological data file, especially in the case where a 

meteorological subset is being used. 

b. A vertical profile of pressure can now be entered. 

c. It is no longer necessary to specify data for every variable in the .prf file.  Now 

only columns for which a profile is to be supplied need to be entered.  The 

height column and one of Year/Day/Hour or Met line number must always be 

specified. 

Old format vertical profile files can still be used with the model, but cannot contain 

any of the new information. 

44. The minimum valid value for surface sensible heat flux (FTHETA0) in the 

meteorological input data has been changed from -100 W/m2 to -200 W/m2. 

45. The time used in the calculation of solar elevation, and hence the solar radiation, has 
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been altered to use the time in the middle of the hour rather than at the end.  In certain 

circumstances, e.g. meteorological conditions entered represent individual conditions, 

it may be desirable to still calculate the solar elevation at the end of the hour, i.e. the 

time as entered for the meteorological data.  The Solar elevation section in the .aai file 

provides the option to determine when the solar elevation is calculated, see Section 

4.16 of the ADMS 6 User Guide. 

Output 
46. The option to specify output locations based on a polar coordinate system has been 

removed from the Grids screen of the interface.  Output grids based on a polar 

coordinate system can be created for an .asp file using the Create ASP grid option, see 

point 47.  The Grids screen now also allows for the specified points in the interface 

and from a file to be enabled independently of each other. 

When upgrading an older .apl which used polar coordinates, all output locations will 

be converted to Cartesian coordinates and stored in a new .asp file.  The Grids screen 

will be automatically set to use this new .asp file and all other options on the Grids 

screen will be turned off. 

47. A new Create ASP grid utility has been added.  This option allows .asp files to be 

created or appended to with grids of points representing rectangular grids aligned with 

the coordinate system, polar grids or rectangular grids aligned with a specific line.  

For each of these cases, regular or variable grids can be specified and output can be 

requested for a series of heights.  See Section 7.7 of the ADMS 6 User Guide for 

more details on the Create ASP grid utility. 

48. A new ‘output per source’ option has been added to write the output contribution from 

each source to each receptor in a new set of output files. The data in these files can 

also be visualised in the Mapper; these ‘footprint’ plots indicate to what degree each 

source contributes to the concentration at the selected receptor for a selected met. line 

(or long-term average) by colour-coding the sources themselves. Instructions for 

using this new option and details of the new output file formats can be found in 

Section 3.6.5 and Section 6.1.20 of the ADMS 6 User Guide, while details about the 

footprint plots can be found in Section 6.5. 

49. A new ‘validity threshold (%)’ column has been added in the Output screen. This 

specifies the threshold percentage of met. lines that need to be valid within a given 

averaging period for that averaging period to be considered valid. See Section 3.6.1 of 

the ADMS 6 User Guide for more details. 

50. Specified points in an .asp file can now be imported directly into the specified points 

table, and vice-versa. 

51. The Comprehensive Output File Processor now includes an option to calculate 

statistics based on temporal subsets of the data.  Subsets can be restricted to specified 

hours of the day, days of the week and/or months of the year.  The minimum, 

maximum or average over these subsets can be calculated.  For more details see 

Section 2.4.4 of the Comprehensive Output File Processor User Guide. 
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Modelling options 

52. A new option to calculate odour hours has been added to the additional input file, 

Section 4.7.2 of the ADMS 6 User Guide.  Two methods are available for determining 

if an hour is classified as an odour hour or not, with long term output then providing a 

count over these hours: 

a. A peak-to-mean method calculates the peak concentration based on an input 

peak-to-mean ratio and then compares this to a threshold 

b. A fluctuations method which makes use of the ADMS fluctuations module to 

determine if more than a specified percentage of the hour exceeds the 

threshold 

53. When using a user input CFD flow field, the complex terrain option should now not 

be selected.  Previously it was required that this option was selected but no 

information from the complex terrain screen was used with the modelling. 

54. A new option has been added to the ‘Switch off stack downwash’ option in the 

additional input file to allow for stack downwash to be switched of for all point 

sources. 

55. A new option has been added to the additional input file to allow the model to 

continue when a plume grounds, e.g. due to being dense.  Without this option selected 

the model will stop with an error for long-term pollutants or skip that met line entirely 

for short-term pollutants, whereas switching this option on allows this check to be 

bypassed.  Even with this option switched on, the interaction between the plume and 

the ground may not be modelled correctly, especially for very dense plumes, so it 

should be used with caution.  See Section 4.23 of the ADMS 6 User Guide for more 

details. 

Minor Changes 

56. Line sources are now modelled as trapezia rather than rectangles.  The shared edge of 

two adjoining trapezia is the bisector of the two centrelines of the line sources.  If 

more than two line sources meet at a point the standard rectangular ends are used for 

each of these sources. 

57. A small correction has been made to the vertical concentration profile used for 

volume sources in convective conditions. 

58. A correction has been made when using volume sources with wet deposition, in which 

the depth was not correctly taken into account in the calculation. 

59. If there are missing/invalid background values for the first modelled hour, the first 

valid values after this hour will be used providing they are within 24 hours. 

60. The page numbering in the various User Guides has been altered so that the printed 
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page numbers match up with those displayed in electronic PDF viewing applications. 

61. The version of AERMOD and AERMET supplied for use with the AERMOD link has 

been updated to 22112 

62. An issue has been fixed which may have caused the model to crash when modelling 

chemistry and calm conditions with wind speeds where the dispersion was considered 

to be a mixture of the radial and Gaussian plumes. 

63. A correction has been made to the calculation of the effective source height to ensure 

the ambient density at the source height is used rather than a default value.  Note that 

this effective source height calculation is only used to determine if the plume is able 

to escape the cavity region with buildings or a reverse flow region with complex 

terrain. 

64. When modelling using the Urban Canopy option the vertical turbulence profile below 

the displacement height will now include a convective component in convective 

conditions. 

65. The shape factor applied when modelling dry deposition for particulates with strong 

gravitational settling has been altered to account for the whole plume settling.  

Previously the shape factor was the same as that used for gaseous pollutants and 

primarily represented removal at the surface. 

66. An additional reaction has been added to the chemistry scheme.  This models the 

reaction of NO with O2 to form NO2 and is only important if NO values are high for a 

long period. 

67. The calculation of wind speed deficit due to wind turbines has been altered to better 

account for any local wind speed adjustments due to varying terrain or roughness.  

Previously the wind speed deficit could be too high in areas where the terrain or 

roughness were also causing the wind to slow down. 

68. An issue has been fixed when modelling line, area or volume sources with calm 

conditions and wind in large sectors that would result in concentrations being too low 

in fully radial conditions. 

69. The modelling of releases with high water content with the plume visibility module 

has been improved.  Previously it was assumed that all water was initially exiting the 

stack as vapour, even when the water content was above the saturation level.  This 

could lead to spikes in temperature immediately downstream of the source.  The 

model now correctly calculates the amount of water exiting the stack as liquid water 

to prevent this issue. 

 


